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Introduction 

How It All Began 
In early 2003 Peter PHP1PH and myself HB9DRV talked about developing a 
simple program to control the soon to be released ICOM IC-703. 

We had previously developed the FT-817 Commander, which proved to be very 
popular, the main lesson being learnt that future programs must not be tied to a 
single radio or a single manufacturer; rather they must be designed to support all 
current and future radios. 

Maybe it was the beer, maybe the desire to give something back to the radio 
amateur community, however on June 6th, 2003 the first line of code was written, 
Ham Radio Deluxe (HRD) was born. 

The inspiration for the design came from a variety of sources: Internet Explorer 
(especially the Favourites), my old Eddystone EA12 and a desire to prove that 
Peter and myself could develop something better than the current ‘not quite so 
free’ products being peddled to radio amateurs. 

On December 23rd, 2005 the number of registered users stood at 20,006 – quite 
an achievement in such a short time. 

 

Very sadly Peter passed away on June 8th, 2005. His contribution to Ham Radio 
Deluxe will never be forgotten. 

 



This Guide 
Kevin Crockett, VK3CKC, wrote the original user guide. Now that HRD is a 
more mature product the time has come to write the document you are currently 
reading. 

If you are reading this – thank-you! 

Requirements 
You can run HRD on any Windows 98 or NT/2K/XP computer. 

There will never be a LINUX or Macintosh native version, HRD is known to run 
under Wine for LINUX and PC emulators for the Macintosh. The code is not 
open source; it cannot be ported to Linux and will never be released as some of 
the code is protected under copyright and cannot be released without landing the 
author with a nice big legal fee. 

I may be crazy undertaking a project like this in my spare time; I am not deep 
stir-fry serve in a bun with extra chilies crazy1! 

You don’t need a radio – HRD comes with built-in Dem-o-matic radio support 
(K2, TS-480, TS-2000 and Orion). 

HRD currently supports these ‘real’ radios: 

• Elecraft: K2 

• FlexRadio: SDR-1000 

• ICOM: IC-7000, IC-703, IC-706, IC-706MkII, IC-706MkIIG, IC-
707, IC-718, IC-725, IC-726, IC-728, IC-729, IC-735, IC-736, IC-
737, IC-738, IC-7400, IC-746, IC-746Pro, IC-751A, IC-751A 
(Piexx), IC-756, IC-756Pro, IC-756ProII, IC-756ProIII, IC-761, 
IC-765, IC-775DSP, IC-7800, IC-781, IC-821H, IC-910H, IC-R10, 
IC-R20, IC-R75, IC-R8500, PCR-1000 

• Kenwood: R-5000, TS-140S, TS-2000, TS-440S, TS-450S, TS-
480, TS-50S, TS-570, TS-60S, TS-680S, TS-690S, TS-790, TS-
850, TS-870, TS-940S, TS-950, TS-B2000 

• Ten-Tec: Argonaut, Jupiter, Orion, RX-350 

• Yaesu: FT-100, FT-1000D, FT-1000MP MkV, FT-600, FT-817, 
FT-840, FT-847, FT-857, FT-890, FT-897, FT-900, FT-920, FT-
990 

• Yaesu: FT-100, FT-1000D, FT-1000MP MkV, FT-600, FT-817, 
FT-840, FT-847, FT-857, FT-890, FT-897, FT-900, FT-920, FT-
990 

You will need a cable to connect your radio to the computer’s serial (COM) port. 
If you don’t have a serial port all is not lost – USB  serial converters are 
widely available. 

Check out the cable solutions from G4ZLP http://g4zlp.ham-radio.ch/ and West 
Mountain Radio http://www.westmountainradio.com/ . 

                                                           
1 Disagree at your peril 
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Installation 

Introduction 
The Ham Radio Deluxe kit is a standard Windows kit – it supports Windows 98, 
Windows 2000 and more recent releases. 

The Logbook requires DAO (Data Access Objects) 3.5 or higher. If you do not 
have DAO 3.5 installed you will get error messages when you start the logbook. 

Ham Radio Deluxe 
Ham Radio Deluxe can be installed in under a minute. Special knowledge is not 
needed – the kit does everything for you! 

 
When you start the installation the first screen shows the release and build you 
are installing. 

 



 
You must accept the licencing conditions. Ham Radio Deluxe is free for radio 
amateurs and shortwave listeners, commercial use requires a licence. 

 

 
Select the folder where Ham Radio Deluxe will be installed, the suggested 
default is usually sufficient. 
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Select the folder in the Start menu where the Ham Radio Deluxe entries will be 
added, the suggested default is usually sufficient. 

 

 
Click Install to start the installation. 

 



 
The progress of the installation is shown while the software is being installed. 

 

 
When the software has been installed select the programs to be started, then 
press Finish. 
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First Steps 

Connection 
Now that you have installed HRD you can try it out using a Dem-o-matic radio. 
This is a reasonable accurate simulation of the real thing, designed for use during 
presentations and while developing HRD when a radio is not available (on the 
train, in a plane, in an airport, stuck in a hotel room in Finland etc.). 

From the Start menu select Programs > Ham Radio Deluxe. Once the splash 
screen has closes you see the Connect window. 

 
 

Dem-o-matic 
The Dem-o-matic radios do not need cables – simply select Dem-o-matic in the 
Company dropdown, select an option in the Radio dropdown, and then press 
Connect. 

They are ideal for demonstrating HRD when you do not have a suitable radio 
available. 

Options 
Company 

Select your radio manufacturer from the drop-down list.  



FlexRadio: you must install the virtual serial port drivers from Philip Covington 
(N8VB). These are used to provide the connection between HRD and the 
PowerSDR sofware which must be running before you try to create the 
connection with HRD. More information is available from http://www.flex-
radio.com/. 

ICOM: disable the CI-V Transceive option for best performance. 

Kenwood: make sure Packet communication mode is switched OFF (if 
supported). Most Kenwood radios require CTS and RTS to be ON for flow 
control. 

Radio 

Select your radio model from the drop-down list. 

COM Port 

The COM port on this computer where you have connected the radio interface 
cable. 

Make sure that you do not have other programs using the same port, for example 
mobile phones and personal organisers. 

Select 'Auto-detect' to try all available ports. 

Speed 

The speed used for communicating with the radio, check the speed setting via 
the radio's configuration menu. 

Select 'Auto-detect' to try all available speeds. 

CI-V Address 

ICOM only: the address assigned to the radio, consult the radio's handbook for 
the default address. This can also be configured via the radio's configuration 
menu. 

CTS 

Enables the CTS flow control, required for Kenwood radios. 

DTR 

Enables the DTR line when the COM Port is opened and leaves it on, usually to 
provide power for an interface cable. For Yaesu CT-62 and ICOM CT-17 
interfaces this can be left unchecked (off). 

RTS 

Enables the RTS line when the COM Port is opened and leaves it on, usually to 
provide power for an interface cable. For Yaesu CT-62 and ICOM CT-17 
interfaces this can be left unchecked (off). 

Connecting 
Press Start to connect to the radio. If you see the error below then the COM port 
is currently held open by another program. 
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Check that you have not started another radio control program. Other culprits are 
PDA and mobile phone connections. Even if you have disconnected a device 
from a COM port you must make sure that the software is no longer running. 

One connected HRD reads the radio’s frequency to ensure that the options you 
selected are correct. If you see the error below then HRD failed to read the 
radio’s frequency: 

 
If HRD can read the frequency the Connect window is replaced with the main 
radio display – you are now using HRD! 

 

What’s Next 
A taste of what’s to come later in this guide… 

Appearance 

Set the appearance: 

• From the View menu select Colour Schemes, 

• Select Customise Layout and Program Options from the Tools 
menu. 





Doc-To-Help Standard Template Radio Display  •  19 

Radio Display 

Introduction 
The HRD radio display has many, many features. This section attempts to 
describe everything you can do in this display. 

To aid in the clarity of the screenshots the LCD Scheme is used. 

 
 

Frequency Display 

 



Configuration 

See Frequency on page 27. 

Dropdowns 

If you have enabled dropdowns as part of the configuration just click on a 
dropdown and make a new selection. 

Mouse Wheel 

When you rotate the mouse wheel in the frequency display the currently active 
digit is incremented / decremented depending on the scroll direction. 

If you rotate while the cursor is over an inactive digit then the digit is activated. 

Up/Down 

The up-arrow, down-arrow, - and + keys increment / decrement the active digit. 

Mouse-click 

Select a digital by clicking over the digit. To increment / decrement click above / 
below the center of the digit and keep the mouse button pressed. 

Direct Entry 

To enter values just press a numeric key (0-9). The active digital is updated and 
the next digit to the right is made active. 

Press Enter to display the Enter Frequency window. 

 
Enter the new frequency, and then press Apply. 

If you check Auto-apply then the new frequency is applied every time you make 
a change. 

If you check Track this window is updated with changes made to the frequency 
display – for example when you tune the radio manually. 

Griffin etc. 

Support for third-party devices such as the Griffin Powermate is available – see 
Accelerators on page 31. 

Tuning Dial 

Fine Tuning 

 

Main Tuning 
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Band Selection 
The Band Section buttons are shown between the Fine and Main layouts. 

 
The buttons are: 

• ALT, 

• BSP, 

• 160m, 80, … 10m. 

Display Scroll 

 

Band Selection 

 

Date & Time 

 

Buttons 

 

Dropdowns 

 

Sliders 
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Customise Layout 

Introduction 
Used to define the appearance of the radio display, Customise Layout is selected 
from the Tools menu, or by pressing the Customise button. 

 

Schemes 

 
Schemes are pre-defined customizations created by author and by other HRD 
users. 

There are four default schemes shipped with HRD: Scheme #1 - #3 and the 
System Default. 

The HRD team and the HRD users have created the other schemes. Special 
thanks to Danielle in Northallerton, UK. 



Select a default scheme by pressing the scheme button (or select an entry and 
press Select); select one of the other schemes by double-clicking on the entry in 
the Schemes list. 

To save the current layout press Save – you will be prompted for a Scheme 
name. 

Use Rename and Delete to organise the available schemes. 

Layout 
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Buttons 

 
Define: 

• Seven button colour combinations, 

• The font, and 

• The button size. 

The default button size is small; this is so that users with low resolutions such as 
800 x 600 still have a usable configuration. 

There are no rules when using the button size; select the size which pleases you 
most. 

For the technical readers the button size is tied to the font size of the radio 
display form (font is Microsoft Sans Serif, size is 8, 9, 10 or 12 point). 

Changing the font size simply changes the font assigned to the form. 



Faceplate 

 
Background 

These colours are applied to the background area of the display and to the 
transmit meters (if any) such as PWR, SWR and ALC. 

Status Window 

The status window displays information which you cannot normally change 
using buttons or sliders in HRD. 

Typical examples are Scanning status, Split mode and Memory channels. 

Clock Position 

The clock is displayed to the left, right or both sides of the band title. 
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Frequency 

 
If your radio supports simultaneous access to two VFO’s (Kenwood, some 
Yaesu) then HRD will display two VFO’s, otherwise just one VFO is displayed. 

First select the VFO you are updating – main or sub. 

The colours you can set are: 

• Background, 

• Frequency – the digits, 

• Active Posn – the bar above and below the current digit, 

• Inactive posn – the bar above and below the other digit, 

The Font can also be set, use the Main > Sub and Sub > Main buttons to copy 
settings between VFO’s. 

Dropdowns 

The dropdown buttons (Mode, Filter…) can be displayed at the top of the main 
frequency display. 

Select: 

• None (no dropdowns), 

•  Mode (only the mode dropdown) or 

• All (all dropdowns). 

If Mode or All is selected you can check Add Border to add a border around the 
text. 

If All is selected you can check Include Title to add the Dropdown button‘s title 
(if there is room). 

 



Meters 

 
The design aim of the bar meters was heavily influenced by my fine Sony stereo, 
still giving fine service here in the HRD R&R suite after some 15 years of abuse. 

The Background and Text colours should be obvious. 

There are three graduation colours: 

• Bars: Low – the first bar colour, 

• Bars: High – the colour at the position set by the High Position 
slider, and 

• Bars: Free – the colour for the free (empty) bars. 

If you check Show peak reading the recent peak value is displayed. 

When HRD is in TX mode the S Meter value is replaced by the value selected in 
the Main and Sub dropdowns, the value you select must be displayed by HRD in 
the upper right hand corner of the display. For Kenwood radios the value to be 
displayed is selected with the meter slider or the individual buttons (SWR / 
Comp / ALC / dB). 

If you check the Always update… option then the S Meter is updated when you 
change frequency – this results in slower performance. 
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Sliders: Appearance 

 
If supported by your radio, sliders are displayed at the bottom of the display. 
Here you define the appearance of the sliders. 

These colours are optionally applied to the sliders in the Advanced selection 
windows (select Advanced from the View menu). 

Sliders: Layout 

 
Here you select the sliders to be displayed. Define up to 6 layouts, for example 
one layout for SSB and another for CW 



Tuning Dial 

 
Here you define the colours, fonts and band button positions. 
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Program Options 

Introduction 
Used to define various HRD features, Program Options is selected from the 
Tools menu, or by pressing the Options button. 

 
 

Accelerators 

 
Define accelerators for use with the Keyboard or with programmable interfaces 
such as the Griffin Powermate. 

When you press Add the definition window is displayed. 



 
Here Ctrl+Alt+W is assigned to the Tune button. Keyboard combinations are 
assigned to display buttons and arrow keys. 

The HRD menu has pre-assigned accelerators; these cannot be redefined. 

Comms 

 
Normally you will not have to change the default settings. 

• Read timeout – serial port timeout. 

• Switch off – some radios such as the FT-817 can be powered down 
using a CAT command. If this option is selected you are prompted 
to switch off the radio. 

• Polling – to reduce CPU load for slower systems. 

• Dual VFO tracking – if selected both VFO’s are tracked on every 
refresh. Only of use with Satellite Tracking (page 55). 

• Refresh interval – the interval between consecutive refreshes of the 
display. 
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COM Port TX 

 
Some early ICOM radios do not support switching between TX and RX using 
CAT commands. The only way to enable computer controlled TX/RX this is by 
toggling a COM port pin. 

You require a special CAT cable if you select this option. 

Docking Panes 

 
HRD uses the excellent programming library from Codejock Software to support 
an advanced docking pane option. 

Docking panes are used for optional windows such as: Bandscope, Calendar, DX 
Cluster, Logbook, Selection, Shortwave Database and WinKey. 

Select whichever visual theme you want – XP is an acceptable default. 

You can also use this theme when a docking frame is floating (not docked). 



ICOM Calibration 

 
ICOM radios return a S Meter value between 0 and 255, normally 0 is S0, 12 is 
S1 and so on. 

As a S Meter unit is 6 dB the algorithm applied is to divide the returned value by 
two to get dB, then divide dB by 6 to get S units. 

Some radios such as the IC-706 have a different logic – use the Offset and Scale 
values to adjust the returned values so that the S Meter in HRD corresponds to 
the S Meter on your radio. 

Info: Modes 

 
Mainly for use by the HRD programming team, all modes for each radio are 
listed. For each mode the mapping to the internal HRD mode is shown. 
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Info: Options 

 
Mainly for use by the HRD programming team, all commands are listed for each 
radio. 

Press Radio for a list of all supported radios. 

To display the commands: 

1. Select a radio, 

2. Press Viewer. 

 



Internet 

 
HRD is able to detect whether you have an Internet connection with 
InternetGetConnectedState(). Uncheck this option if you do not want Internet 
access. 

Out Of Band 

 
Configure the optional sound files played when you tune in / out of band. 
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Mouse Wheel 

 
Define the tuning step when rotating the mouse wheel over the active tuning bar. 

Selection Window 

 
The appearance and operation of the selection window. 

Single-click – normally the Favourites tree folders are opened / closed with a 
double-click. Check this option to enable single-click operation. 

Show numeric value – the Select Windows’s Advanced slider values are 
optionally superimposed on the slider. 

Show the Options icon – historical support for the version 2 Advanced slider 
look and feel. 



Toolbars 

 
Select the toolbar font and whether text is displayed in toolbars. 

The default (suggest) font is Lucida Sans 7 point. 

Updates 

 
Select how frequently HRD reminds you to check for new updates.
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DDE Support 

Introduction 
HRD uses dynamic data exchange (DDE) for inter-process communication. 

DDE allows two or more applications running simultaneously to exchange data 
and commands. 

Available Support 
Select DDE Monitor from the Tools menu to display the supported DDE items. 

 

Commands 
The commands below are supported by HRD. 

 



Add ADIF Record 
ADIF <data> 

Adds a record to the logbook; the record is supplied in ADIF format. Used by 
PSK31 Deluxe. 

Refresh 
REFR button_status  

Refreshes all buttons. 

REFR dropdown_list 

Refreshes all dropdown. 

Set Button 
BUTN button_title=value 

Sets a button state. For normal buttons the value is either on or off. 

 If title starts with @ then it’s a dropdown, the value must be a dropdown value. 

Set Dropdown 
DROP button _title=value 

Selects a dropdown value. 

Set Frequency 
FREQ <hertz> 

Sets the frequency to the value supplied in Hertz. 

Set Mode 
MODE <mode> 

Sets the mode to the supplied value. 

Top Window 
TOPW 

Makes the HRD the top-most window in the Z-order, in other words brings HRD 
to the front of your monitor.
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DX Cluster 

Introduction 
A DX Cluster is a means for Amateur (Ham) Radio operators to tell each other, 
in real-time, about DX stations (other interesting or rare Amateur Radio stations 
all over the world). 

(From http://www.dxcluster.org/ by Dirk Koopman G1TLH) 

One station is set up with Packet Cluster and is linked to one or more other 
stations who have installed the software. These nodes when connected are called 
a cluster. Clusters are connected to clusters, expanding the network. Individual 
users connect to the nodes on a frequency different from what the node stations 
are linked on. Users are capable of announcing DX spots and related 
announcements, send personal talk messages, send and receive mail messages, 
search and retrieve archived data, and access data from information databases 
among its many features. 

(From http://www.dxcluster.org/ by Chuck K6PBT) 

HRD supports: 

• OH2AQ web-based cluster (the original and most widely used), 

• HRD’s own web-based cluster, 

• Direct connections to a DX Spider node using a DX cluster client 
(which in turn uses the telnet protocol). 

The OH2AQ and HRD clusters are available using just your web browser. 



OH2AQ 

 

HRD 

 

Starting 
Select DX Cluster from the Tools menu. 
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When you click on an entry the frequency is sent to the HRD display. 

Configuration 
Press  to open the Configuration window. 

Cluster Source 
There are three possible sources for DX spots: 

3. OH2AQ – the original and most widely used web-based cluster. 
The spots are read by parsing data from the pages on the OH2AQ 
site at http://oh2aq.kolumbus.com/dxs/ . 

4. Ham Radio Deluxe – a web-based cluster with data downloadable 
in CSV format from http://dxcluster.ham-radio.ch/ . These web 
pages were made available by the HRD team as the OH2AQ cluster 
can be overloaded at times, especially at the weekend and during 
contests. 

5. Custom – using the DX Cluster Client built into HRD. Here you 
connect to any DX cluster node. 

OH2AQ / Ham Radio Deluxe 
Using these web-based clusters is the easiest way to get started. All you need is 
an Internet connection. 

OH2AQ supports the Spot option; the Ham Radio Deluxe cluster offers a faster 
response when OH2AQ is overloaded. 

Custom – DX Cluster Client 
This option is only supported on Windows NT/2K/XP. It is not supported in 
Windows 98/ME/SE. 

In the DX Cluster Client pane you connect to a DX Spider cluster, for example 
GB7MBC in sunny Morecambe or HB9DRV in snowy Laax. 



 

Here GD4ELI has logged on to GB7MBC. DX spots are displayed in this 
window as they are received and are sent to the DX Cluster window for 
immediate display. 

 
The advantage here is that you can apply any filtering supported by the DX 
Spider node you connect to. If your interest is European 144MHz then you don’t 
want to see 144MHz spots from the rest of the world. 

Options 
Press  to enable regular updates; the update interval is set by pressing  (not 
applicable is using a custom DX cluster). Press  to refresh the display. 

 
 

Press  to change the font size. 

Select an entry in the display, then press  to perform a lookup of the station 
from the QRZ website. 
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Press  to display the homepage for the selected source (not available if using a 
custom DX cluster). 

 

Press  to submit a spot (not available is using the HRD source). 
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Remote Server 

Introduction 
The HRD Remote Server enables a connection between Ham Radio Deluxe and 
a radio connected to a remote computer that can be contacted via TCP/IP. 

Requirements 
The remote computer must be running Windows NT – that is NT 4.0, 2000, 2003 
or XP. Windows 95, 98 and various flavours thereof are not supported. 

Technology 
A Windows service is installed on the remote service. This listens on a port 
(usually 7805) for incoming connections from Ham Radio Deluxe (the client). 

 Installing 
The HRD Remote Server files are: 

• HRDRemoteSvr.exe – the executable, 

• HRDRemoteSvr.cfg – configuration file, and 

• HRDRemoteSvr README.txt – essential reading. 

To install the service select Remote Service from the Tools> Programs menu. 



 
 

Press Install to install the service, and then press Start to start the service. 

You can start the Windows Services applet (Start – Settings – Control Panel – 
Administrative Tools – Services) to modify the properties of the service, for 
example disabling automatic startup. 

 

Configuring 
Press Configure to edit HRDRemoteSvr.cfg which contains the service 
configuration. 
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The contents of this file should be obvious. After changing the configuration you 
should restart the service. 

Connecting 
To connect to the remote server enter values as normal when starting HRD but 
select the Remote port, then press Connect. 

 
When you press Connect the Remote Connection window is displayed. 

 



 
Enter connection information: 

• Address: the remote computer address in either numeric or alphabetic 
form – for example 195.154.179.101 or www.simon-home.ch . 

• Port: the port assigned to the remote service, usually 7805. 

• Username: a valid username defined in the configuration file. This is 
case-insensitive. 

• Password: the password corresponding to the username. This is case-
insensitive. 

• To save these values make sure the Save settings option is checked X. 

Press Connect. If the connection is successful the text 

Username/password authenticated. Select a remote COM port, then press ‘OK’ 

is displayed. 

 
Now select the COM port, and then press OK to connect to the remote COM 
port and start the HRD radio display. 

When the connection with the radio has been confirmed a Remote Connection 
display window shows you the data throughput and average round-trip time. 
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Remote Connection 

 
Use the Remote Connection window to show the status of the remote connection. 

• Round-trip time: the time required to send a message from HRD to 
the remote server and get a response. This will be very similar to 
the value shown when you use Ping to interrogate a remote host. 
Typically values of 50 milliseconds or less are very usable. 

• Refresh interval: the interval between refreshes of the selected 
Regularly Read options. 

• Send frequency: when the frequency is updated over a link with a 
high round trip time (> 100ms) the performance will be less than 
optimal with Sync selected so if the round trip is high select Async, 
otherwise just select Sync. The disadvantage of using Async is an 
'elastic band' effect while tuning by dragging HRD's small tuning 
marker.  

• Regularly Read: the options that are regularly updated. If you are 
using a fast link - for example to a local station with a low round-
trip time then you can safely select all options. The disadvantage of 
selecting options such as Buttons, Dropdowns, Sliders and Status 
Texts is that it may take a second or two before HRD detects that 
you are changing the frequency by dragging the tuning marker and 
the current refresh operation cannot be interrupted.  

Slow Link 
If you have a slow link - a round-trip time > 100 ms - then select only Meters. As 
this is a remote station it is unlikely that anyone else will be adjusting the radio's 
controls so you will not need to refresh buttons and dropdowns as you would 
with a locally connected radio. 

The disadvantage of not selecting Buttons and Dropdowns is that inter-button 
dependencies will not be shown - for example you may have 4 AGC buttons Off, 
Fast, Medium and Slow, only one of which will be active at any one time. If 
Buttons is not enabled for regular refreshes then pressing Fast will not update the 



other AGC buttons. In this case you must press the small refresh button to the 
right of the Buttons check box. 

To refresh all display options click Refresh All. 

Technical Information 
Remember that the software is designed for Windows NT but it should be 
possible to map all these commands to Linux and other UNIX derivatives. 

The source code for the main processing thread is available; the rest is highly-
Windows oriented and is of no use for other platforms. 

Commands 
The supported commands are: 
Command Description 
MSG_CMD_AUTHENTICATE Authenticate username/password 
MSG_CMD_CLOSE_HANDLE Close COM port. 
MSG_CMD_CREATE_FILE Open a COM port 
MSG_CMD_DEVICE_IO_CONTROL Send control code to COM port driver 
MSG_CMD_GET_COM_PORTS Return a list of COM ports 
MSG_CMD_PURGE_COMM Discards all characters from the input buffer 

of the COM port. Terminates pending read 
or write operations on the resource 

MSG_CMD_READ_FILE Read the COM port 
MSG_CMD_READ_FILE_EX Read the COM port (extended read) 
MSG_CMD_SET_COMM_MASK Specify events to be monitored. 
MSG_CMD_SET_COMM_STATE Configure COM port. 
MSG_CMD_SET_COMM_TIMEOUTS SET timeouts. 
MSG_CMD_WRITE_FILE_ASYNC Asynchronous write, no reply expected 
MSG_CMD_WRITE_FILE_SYNC Synchronous write (reply expected) 

 

All commands expect a reply except for MSG_CMD_WRITE_FILE_ASYNC. 

The command values are: 

enum RemoteSvrMessages 
{ 
 MSG_CMD_AUTHENTICATE      = 0,
 MSG_CMD_GET_COM_PORTS     = 1,
 MSG_CMD_CREATE_FILE       = 2,
 MSG_CMD_DEVICE_IO_CONTROL = 3,
 MSG_CMD_SET_COMM_MASK     = 4,
 MSG_CMD_PURGE_COMM        = 5,
 MSG_CMD_SET_COMM_STATE    = 6,
 MSG_CMD_SET_COMM_TIMEOUTS = 7,
 MSG_CMD_READ_FILE         = 8,
 MSG_CMD_READ_FILE_EX      = 9,
 MSG_CMD_WRITE_FILE_SYNC   = 10,
 MSG_CMD_CLOSE_HANDLE      = 11,
 MSG_CMD_WRITE_FILE_ASYNC  = 12, 
}; 
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Structures 
The structures used are shown below. All members are byte-aligned. All 
commands start with the structure 

typedef struct { 
    UINT nSize;     //  Total command size 
    UINT nHead;     //  4 bytes, ‘HRD*’ 
    UINT nCmd;      //  Command index 
} MSG_HEADER; 

• nSize - the total size in bytes of the message being sent. 

• nHead – 4 bytes  of sanity– ‘HRD*’. 

• nCmd – a command from the table below. 

 
Command Structure 
MSG_CMD_AUTHENTICATE MSG_AUTHENTICATE 
MSG_CMD_CLOSE_HANDLE MSG_COM_PORT 
MSG_CMD_CREATE_FILE MSG_COM_PORT 
MSG_CMD_DEVICE_IO_CONTROL MSG_COM_PORT 
MSG_CMD_GET_COM_PORTS MSG_GENERAL 
MSG_CMD_PURGE_COMM MSG_COM_PORT 
MSG_CMD_READ_FILE MSG_COM_READ 
MSG_CMD_READ_FILE_EX MSG_COM_READ 
MSG_CMD_SET_COMM_MASK MSG_COM_PORT 
MSG_CMD_SET_COMM_STATE MSG_COM_PORT 
MSG_CMD_SET_COMM_TIMEOUTS MSG_COM_PORT 
MSG_CMD_WRITE_FILE_ASYNC MSG_COM_WRITE 
MSG_CMD_WRITE_FILE_SYNC MSG_COM_WRITE 

 

MSG_AUTHENTICATE  

typedef struct { 
 MSG_HEADER header; 
 BOOL  bAuthenticated; 
 char  szUsername[64]; 
 char  szPassword[64]; 
 char  szStatus[512]; 
} MSG_AUTHENTICATE; 

 

MSG_COM_PORT  

typedef struct { 

 MSG_HEADER  header; 
 char   lpFileName[32]; 
 DWORD   dwDesiredAccess; 
 DWORD   dwCreationDisposition; 
 
 DWORD   dwIoControlCode; 
 BYTE   byInBuffer[64]; 
 DWORD   dwInBufferSize; 
 BYTE   byOutBuffer[64]; 
 DWORD   dwOutBufferSize; 
 DWORD   dwBytesReturned; 



 
 DWORD   dwFlags; 
 DWORD   dwEvtMask; 
 
 DCB   dcb; 
 COMMTIMEOUTS timeouts; 
 
 HANDLE  hHandle; 
 BOOL   bStatus; 
 char   szStatus[256]; 
} MSG_COM_PORT; 

 

MSG_GENERAL  

typedef struct { 
 MSG_HEADER header; 
 BOOL  bStatus; 
 BYTE  byData[4096]; 
} MSG_GENERAL; 

 

MSG_COM_READ  

typedef struct { 
 MSG_HEADER  header; 
 HANDLE  hHandle; 
 DWORD   dwNumberOfBytesToRead; 
 BYTE   byTermChar; 
 DWORD   dwNumberOfBytesRead; 
 BOOL   bStatus; 
 OVERLAPPED  overlapped; 
 BYTE   byData[4096]; 
} MSG_COM_READ; 

 

MSG_COM_WRITE  

typedef struct { 
 MSG_HEADER  header; 
 HANDLE  hHandle; 
 DWORD   dwNumberOfBytesToWrite; 
 DWORD   dwNumberOfBytesWritten;
 OVERLAPPED  overlapped; 
 BOOL   bStatus; 
 BYTE   byData[4096]; 
} MSG_COM_WRITE; 
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Satellite Tracking 

Introduction 
If you are new to satellite tracking visit http://www.amsat.org/ maintained by 
The Radio Amateur Satellite Corporation (AMSAT) for excellent articles written 
for new satellite users. 

HRD’s Satellite Tracking support would not be possible without the help of 
David Taylor and his open source satellite-tracking library. 

After using David’s code to get started I wrote my won library, shipped as a 
DLL with HRD and based on NORAD SGP4/SDP4 Implementations by 
Michael F. Henry. Full source is available on request. 

The most important rule: it's the frequency on the satellite that is important, not 
the frequency on your radio. This is the most common mistake made when using 
a satellite. 

If you are using two radios for satellite tracking – one for transmit, the other for 
receive – read this section first, then refer to Dual Radio Satellite Tracking on 
page 70. 

Dual radio support is arguably the most flexible way to work with satellites. 

Satellites 
The software requires information about the satellites you will be tracking, this 
information is known as Keplerian elements. Johannes Kepler (1571 – 1630) 
discovered the three laws of planetary motion in 1609 and 1619 – a remarkable 
feat! 



 
The satellites window lists the files containing the Keplerian elements used to 
plot the position of satellites and compute the correct frequencies for the uplink 
and downlink. 

The default folder is Satellites located below the folder where you have installed 
HRD - for example: 

C:\Program Files\Amateur Radio\Ham Radio Deluxe\Satellites. 

To change the folder just press Select. 

It is recommended that you update the data files in the Satellites folder when you 
start using Ham Radio Deluxe as the files shipped in the kits will be out of date 
by the time you start to use them. These files should ideally be refreshed every 
few days. 

If you check the ‘Download when Satellite Tracking starts’ option then the files 
are downloaded every time you start satellite tracking. 

To download the latest Kepler data files press Download. The files are 
downloaded to the folder containing your satellite data. 

To edit the list of files press Edit List. The file is HRD Satellite List.txt in the 
folder Satellites folder. 

Example: 
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New satellite data files can be downloaded from the Internet, for example from 
http://www.amsat.org/ or from http://www.celestrak.com/ maintained by T.S. 
Kelso. 

The only supported file format is two-line element sets, for example: 

 
The verbose format is not supported.  

The bare NASA format elements from http://www.amsat.org/ contain all 
satellites of interest to radio amateurs. 

Alternatively if you look at http://www.celestrak.com/NORAD/elements/ you 
will see many files that can be downloaded. Just download these files and save 
them in the Satellites folder selected previously. For more information about the 
contents of these files browse http://www.celestrak.com/. 

All text files in the Data Folder are loaded into Ham Radio Deluxe, so you 
should delete old files if you no longer need them. 

Select up to 100 entries from the Available list by either double-clicking on 
individual entries or by highlighting one or more entries and pressing  >  . By 
pressing  >>  all entries (up to a maximum of 100) are moved to the Selected list. 



Observer 

 
In the Observer window you enter your location and height above sea level in 
meters or feet (for users more familiar with imperial measurements: 1 metre is 
3.3 feet). You also enter an optional list of stations that are plotted on the world 
maps. Only the checked [X] entries are plotted. 

Enter your location either: 

6. By entering your Maidenhead Locator in the Locator field and the 
pressing Convert >>  or 

7. By entering the Latitude and Longitude directly. 

You also select the preferred time format; either Local (default) or UTC. 
Distance is displayed in either kilometers or miles. 

You must press Apply to update the satellite settings. 
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Ground Control 

 
This window is used to adjust your radio's TX (uplink) and RX (downlink) 
frequency to compensate for the Doppler effect, which is the apparent shift in 
frequency of a wave due to the relative motion of source and observer. Doppler 
shift is calculated in accordance with Kepler's laws. 

• Enter the satellite uplink (your TX) frequency in the Satellite TX 
field. 

• Enter the satellite downlink (your RX) frequency in the Satellite 
RX field. 

• Select the VFO you will use for TX and RX (see rest of this 
section). 

• If you are using a transverter enter the transverter offsets. 

When you are tuning remember that the important frequency is the satellite 
frequency, not the frequency on your radio. The frequency on your radio is the 
satellite frequency corrected for Doppler shift. 

Kenwood TS-2000 
The computer can only update both main and sub frequencies either: 

• In receive mode, or 

• In transmit mode with SAT selected. 

A special solution is required when the uplink (TX) and downlink (RX) 
frequencies are in the same band. When you start the TS-2000 you have an extra 
TX VFO option Sub+XIT which is only used for same band split operation (see 
below). When selected the Sub VFO is used for transmitting, Doppler correction 
is applied by adjusting the XIT value. 

Cross Band 
In normal cross-band satellite mode (for example transmit on 70cms and receive 
on 2m) select: 



• TX VFO B/Sub (the TS-2000 always uses the Sub VFO for 
TX), 

• RX VFO A/Main, 

• SAT on, 

• Split off. 

The TS-2000 must be in satellite mode so that the computer can update the TX 
frequency. 

Be careful with the TS-2000's TF SET button, each time you press TF-SET the 
uplink (TX) frequency and the downlink (RX) frequency are swapped. So if the 
frequencies in HRD are the opposite of those shown on the radio just press TF 
SET once. 

Same Band (Split) 
An example is talking to the astronauts on the ISS where the TX frequency is 
145.200.000 MHz and the RX frequency is 145.800.00 MHz. You cannot use 
SAT mode as this is only used for cross-band operation, so you use Split mode. 

• TX VFO Sub+XIT, 

• RX VFO Main, 

• SAT off, 

• Split on. 

XIT will be switched on as soon as you check TX [X] updates. If you switch it 
off then HRD will switch it on again. 

The RX (main) frequency on the TS-2000 is set to the correct RX frequency 
(satellite + Doppler correction). 

The TX (sub) frequency on the TS-2000 is set to the TX satellite frequency; the 
Doppler correction is applied by adjusting the XIT value. When you transmit the 
TS-2000 displays the TX (sub) frequency +/- XIT so the frequency displayed on 
the TS-2000 is the correct frequency (satellite + Doppler correction). 

When you start transmitting you may hear beeps from the radio - it takes HRD a 
few seconds before it detects that you are transmitting. When HRD detects 
transmit mode it stops updating the RX (main) frequency intil you return to 
receive as the frequency cannot be updated by the computer while transmitting 
with SAT off. 

Yaesu 

FT-847 
You must select SAT mode on the FT-847 so that Ham Radio Deluxe can read 
and set both the TX and RX frequencies. It is not possible to determine the state 
of the FT-847's SAT button so you must press the SAT button in HRD so that it 
shows SAT as being enabled. 

In normal cross-band satellite mode (for example transmit on 70cms and receive 
on 2m) select: 

• TX VFO B/Sub, 

• RX VFO A/Main, 

• SAT on, 

• Split off, 
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• Tracking off (you do not need to enable tracking, the computer 
does everything for you, also the tuning response with HRD is 
much faster with tracking off). To switch tracking off press the A > 
B button underneath Track. 

The FT-847 must be in satellite mode so that the computer can update the TX 
frequency. 

When in SAT mode the FT-847 takes a long time to respond to 'Read Frequency' 
requests - especially if tracking is on, as a result when you tune the FT-847 with 
the radio's tuning dial the displayed frequency will not update very quickly. 

Other 
The transmit frequency of some Yaesu radios such as the FT-817 and FT-857 
cannot be changed while in transmit mode, so it is not possible to apply Doppler 
correction while transmitting. If you think your Yaesu radio can be updated 
while transmitting please contact the author. 

ICOM 

IC-910H 
In normal cross-band satellite mode (for example transmit on 70cms and receive 
on 2m) select: 

• TX VFO Sub, 

• RX VFO Main, 

• SAT on. 

The IC-910H must be in satellite mode so that the TX uses the Sub frequency. If 
the bands on the radio are the same as HRD but reversed press M / S to switch 
the Main and Sub frequencies. 

Because the IC-910H cannot display the same band on both Main and Sub HRD 
cannot update the frequencies unless the correct bands are select using the radio 
controls. 

In same-band mode: 

• TX VFO Main, 

• RX VFO Main, 

• SAT off. 

A few notes: 

1. The TX mode is not updated from the radio. 

2. The software has to switch between Main and Sub so that the Sub 
VFO is updated, it is not possible to detect the radio's current Main 
/ Sub selection so the radio operates in main mode all the time. If 
you press Sub on the radio you will see that radio switch back to 
Main as soon as the Sub frequency is updated. 

Single VFO Radios 
If you are using a single VFO radio such as the FT-817 then you use the same 
VFO for TX and RX. Use the TX (F1) button to switch between TX and RX. 
When you switch to TX the transmit frequency is loaded into the radio before it 
switches to transmit, when you return to receive the receive frequency is loaded 
into the radio after it switches to receive. 



So the rule is: always use the TX (F1) button to switch between transmit and 
receive. 

Linear Transponders 
Check [X] the Linear Transponder Tracking option if you are using a linear 
transponder such as HAMSAT / VUSAT / VO-52. These satellites receive a 
specific range of frequencies (typically 40 - 100 kHz) in one band, convert them 
to another band and amplify the converted signal for transmission back to your 
planet. The converted signal is inverted - LSB becomes USB etc. - this is known 
as an inverting transponder. 

Do not use the satellite tracking built into your radio - let HRD do the work for 
you (for example on the FT-847 this is the Tracking option). To set up the linear 
transponder frequencies: 

• TX center The center frequency of the uplink (TX) band. For 
example on VO-52 the uplink band is 435.220-435.280 MHz 
(LSB/CW) so the center frequency is 435.250.000 MHz. 

• RX center The center frequency of the downlink (RX) band. For 
example on VO-52 the downlink band is 145.870-145.930 MHz 
(USB/CW) so the center frequency is 145.900.000 MHz. 

As you tune your RX frequency the TX frequency will be correctly adjusted by 
applying [1] offsets from the center frequencies and then [2] Doppler correction. 

To adjust your transmit signal so that it matches the receive frequency use the 
spin button to the right of the TX center field. It will be necessary to adjust the 
transmit signal as your radio(s) may not be correctly aligned, also the linear 
transponder in the satellite may also not be correctly aligned. 

The tracking option in a radio cannot correctly compensate for Doppler, this is 
one reason why many QSO's drift gently across the linear transponder's available 
bandwidth. Only correct computer control will ensure that two or more stations 
stay on the same frequency while the satellite passes overhead. When using the 
linear transponder option HRD will correctly control your radio's frequencies so 
that are they are both compensated for Doppler shift. 

Frequency Resolution 
The frequency resolution is set the 1 Hz for: 

• All ICOM, 

• All Elecraft, 

• All FlexRadio, 

• All Kenwood . 

All other radios are set to 10 Hz. If you have a radio that supports 1 Hz 
resolution and is not in the above list please contact the author. 

Options 
Option Description 
VFO The VFO used for the uplink (TX) and downlink (RX). If checked [X] the 

selected VFO is updated regularly as the satellite frequency is corrected 
for Doppler shift. 

Satellite The satellite frequency. Click the Open button to select a new frequency 
from a popup window containing the Favourites definitions or enter the 
new frequency. 

Transverter If you are using a transverter enter your transverter's intermediate 
f h d h k h b f i
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frequency here and check the [X] box. If you are not using a transverter 
either leave this field empty or do not check the [X] box. The radio 
frequency is calculated as: Satellite - Transverter + Doppler shift. 

Radio The radio frequency as computed by HRD taking Doppler shift into 
account. 

Satellite Select the current satellite from a dropdown list that contains the entries 
selected earlier in the Satellites window. 

Plot for Determines the amount of information that is plotted over the surface of 
the planet for the current satellite. 

TX > RX Copy the Uplink satellite frequency to the Downlink satellite frequency. 
RX > TX Copy the Downlink satellite frequency to the Uplink satellite frequency. 
TX <> RX Exchange the Uplink and Downlink satellite frequencies. 

Schedule 

 
This window shows the pass schedule for the satellites selected in the Satellites 
window. 



Current Data 

 
This window shows all computed information for a selected satellite. This 
window provides the data for the Ground Control and DDE windows. 

Press Viewer to display the data with the default text file viewer, usually 
Notepad. 

Mutual Visibility 

 
The mutual visibility window answers the question 'when is a satellite 
simultaneously visible from two or more locations'. 

The information is determined up to 99 days in the future for any stations from 
the list defined in the Observer page. 
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The satellite is considered to be visible if the elevation is the same as or greater 
than the selected value. 

Use the Viewer option to display the data in Notepad, for example: 

 

Visibility 

 
The visibility window gives you an overview of the satellites you have selected 
in the Satellites window. 

Select the satellites that are displayed: 

• All - displays all satellites, 



• Visible now - displays only the satellites which are currently 
visible, 

• Visible in next… - displays the satellites visible at any time in the 
time period you select, for example the next 60 minutes. 

For each entry in this display the columns are:  
Column Description 
Vis Whether the satellite is currently visible. 
Satellite The name of the satellite. 
Azimuth The azimuth of a satellite is the angle between the vertical plane containing 

it and the plane of the meridian. It is customary to reckon the azimuth of a 
line from the south point of the horizon around by the west from 0[deg] to 
360[deg]. 

Elevation The angular distance above the horizon. 
AOS Acquisition of signal is the elapsed time at which the satellite becomes 

visible and a signal can theoretically be heard. If empty then the satellite is 
already visible. 

LOS Loss of signal is the elapsed time after which the satellite is no longer 
visible and the signal can theoretically no longer be heard. 

Lon The satellite's current longitude. 
Lat The satellite's current latitude. 
Range The distance of the satellite from the observer's location measured in 

kilometers. (A mile is 1.6 kilometers; a kilometer is 0.62 miles.) 
Altitude The altitude of the satellite above sea level measured in meters. 
Range 
Rate 

The value required to calculate Doppler frequency adjustment. 

 

Next Passes 

 
This window shows up to 1,000 passes for a selected satellite. Note: do not 
select more than 100 passes unless you have a very powerful computer, 
minimum CPU frequency of 2 GHz is recommended. 

Press Alarm to add an audio alarm when a satellite is about to pass overhead. 
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Press Plot to plot a selected pass in the Single Pass window. 

Press Viewer to display the data with the default text file viewer, usually 
Notepad. 

Single Pass 

 
This window plots a single pass for the satellite selected in the Next Passes 
window. The elevation is plotted on the left y-axis; time is on the x-axis. Select 
Azimuth, Altitude or Range to be plotted on the right y-axis. 

If Popup info is checked a vertical dashed marker line is displayed which either 
tracks the current time or is positioned by clicking on the chart with the left 
mouse button. 

As the marker position changes, the azimuth, elevation, altitude and range are 
displayed in the marker fields. 



Plot 

 
This window shows the position of one to four satellites above the surface of the 
planet. 

DDE 

 
This window controls the DDE server. If you want to use HRD's data with 
another program you must start HRD's DDE Server. Select the DDE format: 
currently only Nova is supported. Press Start to start the DDE server. 
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Synchroniser 

Introduction 
The synchronizer is used to control two or more radios where a common 
frequency is shared by using the Dynamic Data Exchange (DDE) mechanism. 

For each radio you are using you start an instance of HRD, one instance is the 
Master, the rest are the Slaves, the slaves receive frequency and mode 
information from the master. 

Starting 
Start the Synchroniser from the Tools> Programs menu, then press Scan to find 
the active HRD instances. 

 
Select the master instance (supplied the frequency and mode), and then press 
Start. 



 
In the Frequency and Mode dropdowns you select the corresponding source from 
the HRD master instance: 

• Radio – as seen on the main HRD display, 

• Transverter – frequency is taken from the Transverter window 
(selected from the Tools menu). 

• Satellite uplink – the uplink frequency and mode (see Ground 
Control on page 59). 

• Satellite downlink – the downlink frequency and mode (see Ground 
Control on page 59). 

In the HRD Slaves group box check the instances to be controlled by the 
Synchroniser. 

As soon as you check a slave the slave’s frequency and mode are updated with 
the current values from the master; every time the master frequency and / or 
mode change they are sent to the slave for so long as the slave option remains 
checked. 

Dual Radio Satellite Tracking 
For more information about satellite see Satellite Tracking on page 15, 
specifically Ground Control on page 59. 

If you are using two radios for satellite tracking (for example two FT-817 or IC-
7000): 

1. Start an instance of HRD for each radio; connect to the radios. 

2. Select an instance to use as the master, in this example the radio 
used for receive. 

3. In the master (receive) instance: 
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• Start the display.  

• Enter transmit and receive frequency information for the 
satellite you are tracking. 

• Check the RX VFO, do not check a TX VFO as this 
instance will not be used for transmit. 

4. Start the Synchroniser: 

• Master is the receive instance, 

• Slave is the transmit instance, 

• Select the Satellite uplink option for Frequency and Mode so 
that the slave receives the frequency and mode used for 
transmit as computer by the Master instance. 

The slave will now be updated with the transmit frequency and mode for 
transmit every time it changes in the master instance. 

 


